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1Getting Started

System Requirements
The minimum system requirements to install and operate the Comcast Connection 
Manager are shown in the table below.

Additional Requirements
• Compatible Comcast 3G or 4G Mobile Broadband Device for Mobile connections.

• Compatible Wi-Fi device for Wi-Fi connections

Windows XP Windows VIsta

Processor 300 MHz 1 GHz 
(1.25 GHz recommended)

RAM 256 MB 1 GB 
(2 GB recommended)

Hard Drive Space 60 MB 75 MB

Internet Explorer IE 5.5 (or higher) IE 7 (or higher)

Windows Service Pack Service Pack 2 (or higher) -
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Installing the Comcast Connection Manager 
Software
Installing the Comcast Connection Manager is easy. Complete the following steps to install 
the Comcast Connection Manager software:

1. Insert the CD into your computer’s CD ROM drive.

2. If your computer automatically starts the installation program from the CD, follow the 
on-screen instructions for installation and configuration.

If your computer does not automatically install the software from the CD:

a. Open the My Computer folder (on Windows Vista, this folder is simply called 
Computer). 

b. Browse to the CD drive in My Computer (or Computer), and double-click on the 
CD drive icon.

c. Double click on the Setup icon to begin installation. 

d. Follow the on screen instructions to install and configure the Comcast 
Connection Manager application.

Note: Once the Comcast Connection Manager software is installed, supported wireless 
devices will be detected automatically by the Comcast Connection Manager whenever 
you attach them. DO NOT plug the Comcast Mobile Broadband Device into your computer 
until you have completed the Comcast Connection Manager Installation. Inserting the 
device prior to installing the Comcast Connection Manager could result in the device 
drivers being configured incorrectly. 
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Launching the Comcast Connection Manager
Once your hardware is installed and ready to connect, you may go ahead and launch the 
Comcast Connection Manager by doing one of the following:

• Double-click the Comcast Connection Manager icon on your computer’s desktop

• In the Start menu, select Programs or All Programs > Comcast > Comcast 
Connection Manager > Comcast Connection Manager.
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2The Comcast Connection 
Manager Interface

Getting Connected
By default, the Comcast Connection Manager will automatically connect to an available 
network. It will seek to connect to Wi-Fi, 4G Mobile and 3G Mobile networks (in that order). 
You can also manually connect to a network, by first turning off the auto-connection 
feature. Wi-Fi connections may require additional configuration first, but the basics of 
establishing a connection are simple:

1. If you are already connected to a network whose connections are not managed by 
the Comcast Connection Manager, you must shut that connection down before 
establishing a connection with the Comcast Connection Manager (only one 
connection is allowed at a time). 

Note: Manually disconnecting switches off the auto-connect feature until you restart 
the Comcast Connection Manager application.

2. Select the network to which you want to establish the connection by clicking one of 
the lines of the Supported Networks List. 

Note: If more than one available Wi-Fi network is detected, the Comcast Connection 
Manager will select one for you. To choose a different network, click View All Wi-Fi, 
which displays the complete list of Wi-Fi networks detected (see page 24).

3. Click the Connect button to establish a connection to the currently-selected network.

Click to Open
WiFi Networks List

Supported
Networks List

Connect/Disconnect
Button
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Note: Because only one connection is allowed at a time, any other connection will be 
shut down when you click Connect.

See Chapter 3, “Mobile Connections” for more information on establishing 3G mobile and 
4G mobile connections. See Chapter 4, “Connecting to Wi-Fi Networks” for more 
information on establishing Wi-Fi connections.
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Supported Networks List: In Detail
The main window of the Comcast Connection Manager interface features a list of the 
supported networks. The networks for which you have a supported device installed will be 
displayed in black. Those for which you do not have a supported device installed will be 
gray. 

The columns in this list include the following:

Connection Indicators
If you are currently connected to a particular network, the corresponding connection 
indicator will be lit (green). Other networks (to which you are not connected) remain gray.

Network Name
Networks supported by the Comcast Connection Manager are listed in this column. If the 
Mobile 3G network displayed is not Comcast's network, the  symbol will appear next to 
the network's name to indicate that this is a roaming network. 

Status
A brief textual description of the connection status for the currently-selected network (for 
example, “Ready to Connect” or “Connected”). 

If the Comcast Mobile Broadband Device you are currently using is a 4G only device, this 
column will contain a “What's 3G?” link. Click this link to view information on upgrading to 
3G/4G dual mode service.

Network Type
This column indicates whether each supported network is Mobile (3G or 4G) or Wi-Fi.

An icon will appear in this column if the network to which you are currently connected has 
been secured using encryption technologies.

Signal Strength
Indicates the current strength of signals being received from this network. Stronger signals 
tend to produce more reliable connections.

Connection
Indicators
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Menus in the Main Window

The File Menu
Click File in the menu bar of the Comcast Connection Manager's main window to produce 
a menu with the following options:

Enable/Disable Wi-Fi
Select this option to enable and disable Wi-Fi. Use the disable option when you want to 
prevent your Wi-Fi adapter from establishing connections or consuming your laptop's 
power. 

Enable/Disable Comcast Mobile 3G 
Select this option to enable and disable your Comcast 3G Mobile Broadband Device. Use 
the disable option when you want to prevent your Comcast 3G Mobile Broadband Device 
from establishing connections or consuming your laptop's power.

Enable/Disable Comcast Mobile 4G
Select this option to enable and disable your Comcast 4G Mobile Broadband Device. Use 
the disable option when you want to prevent your Comcast 4G Mobile Broadband Device 
from establishing connections or consuming your laptop's power.

Exit
Exit the Comcast Connection Manager application and close any wireless connections.
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The Tools Menu
Click Tools in the menu bar of the Comcast Connection Manager's main window to 
produce a menu with the following options:

Profiles
Select this option to display the Network Profiles window (see page 30). This window is 
used to create, edit and prioritize network profiles.

Diagnostics > Wi-Fi Info
Select this item to open the Wi-Fi Info window. This window displays technical information 
about the Wi-Fi network to which you are currently connected (if any) and the associated 
Wi-Fi device.

Diagnostics > Comcast Mobile 3G Info
Select this item to open the Mobile Info window. This window displays technical 
information about the 3G Mobile network to which you are currently connected (if any) and 
your Comcast 3G Mobile Broadband Device.

Diagnostics > Comcast Mobile 4G Info
Select this item to open the Comcast Mobile 4G Info window. This window displays 
technical information about the 4G Mobile network to which you are currently connected (if 
any) and your Comcast 4G Mobile Broadband Device.

Diagnostics > Event History
Select this item to display a list of the most recent Comcast Connection Manager events 
(network connections, network disconnection, errors, etc.).

Diagnostics > Generate Diagnostics
Select this item to generate a file containing diagnostic information. Comcast technical 
support may ask you to generate and email the file to aid in diagnosing connection 
problems.

Check for Updates
Select this item to check for updates to the Comcast Connection Manager software and its 
databases.

Settings
Select this item to open the Settings window, which allows you to configure a number of 
features to your personal preference.
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The Help Menu
Click Help in the menu bar of the Comcast Connection Manager's main window to 
produce a menu with the following options:

Help
Select this item to open the Comcast Connection Manager’s help system.

About the Comcast Connection Manager
Select this item to display version information for the Comcast Connection Manager 
software.
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Other Items in the Main Window
The following other items appear in the main window:

Connection Indicators
These indicators are similar to the connection indicators on the leftmost column of the 
Supported Networks List. However, the Mobile indicator indicates a connection to either a 
3G mobile network or a 4G mobile network.

Refresh Button
Click this button to refresh the information in the window.

My Comcast Button
When connected to one of the networks listed above, clicking this button opens your 
browser to the Comcast home page.

My Comcast
Button

Refresh
Button

Connection
Indicators
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Minimizing the Main Window
The buttons in the upper-right corner of the main window control the appearance and 
location of the window.

Minimize Button
Similar to the minimize button in most Windows applications, this reduces the Comcast 
Connection Manager to a panel on the task bar.

Click this panel to return the Comcast Connection Manager to full size.

Close Button
Click this button to close the main window but leave the Comcast Connection Manager 
running in the background. The smaller version of the main window (shown below) 
appears in the corner of your screen.

After a few seconds, this window closes automatically and only the system tray icon 
remains on the screen (see page 17).

Close
Button

Minimize Button
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Using the System Tray Icon
Whenever the Comcast Connection Manager software is running, the icon shown below 
appears in the system tray (the row of icons next to the clock on the taskbar). 

The icon remains in the system tray as long as the Comcast Connection Manager is 
running, even if the main window has been closed. Click once on this icon to open a small 
window with the ability to connect and disconnect. Note that this smaller version of the 
main window only remains on screen for a few seconds (just long enough to establish a 
new connection).

Double-click on the system tray icon to open the main window (if it is closed) and to move 
it in front of other open applications.

The Right-Click Menu
Right-click on the system tray icon to produce a menu with two options:

• Select Settings to open the Settings window (see Chapter 7, “Comcast Connection 
Manager Settings”).

• Select Exit to close the Comcast Connection Manager application.

Comcast Connection
Manager Icon
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3Mobile Connections

Manually Connecting to a Mobile Network
By default, the Comcast Connection Manager will automatically select an available 
wireless network and establish a connection. But, you can choose a different network if 
you like. To manually connect to a mobile network, follow these steps:

1. Connect your Comcast Mobile Broadband Device. 

2. Select either Comcast Mobile 3G or Comcast Mobile 4G in the main window.

3. Click the Connect button to connect.

Note: Manually choosing a network to connect to stops the Comcast Connection Manager 
from automatically connecting to networks for the duration of the session. If you want to 
return to automatic connection mode, you must restart the Comcast Connection Manager.
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4Connecting to Wi-Fi 
Networks

Manually Connecting to a Wi-Fi Network
If you have a Wi-Fi-enabled laptop, or a computer with an external Wi-Fi device attached, 
the Comcast Connection Manager will enable you to connect to nearby Wi-Fi networks. 
When there are nearby Wi-Fi networks available, the Comcast Connection Manager will 
select a network to connect to and display its name.

By default, the Comcast Connection Manager will automatically establish a connection to 
an available wireless network. But, you can choose a different network if you like. Follow 
these steps to connect:

1. Select Wi-Fi in the Comcast Connection Manager’s main window. 

2. To connect to the network whose name is displayed, click Connect.

To connect to a different network, click the View All Wi-Fi link. The drop down menu 
that appears lists all available networks (see page 24). Select the network you want 
to connect to and then click the Connect button.

Note: A *closed* item under Network Name indicates the presence of one or more 
closed networks. See “Accessing a Closed Network” on page 25 for more 
information.

Note: Manually choosing a network to connect to stops the Comcast Connection Manager 
from automatically connecting to networks for the duration of the session. If you want to 
return to automatic connection mode, you must restart the Comcast Connection Manager.

Prompts
Once the Comcast Connection Manager has connected to the selected network, you may 
see the following prompts:

• If the network is encrypted, you will be prompted to enter an encryption key. Enter it 
and click OK or click Cancel and select a different network. See “Introduction to Wi-Fi 
Encryption” on page 26 for more information on connecting to encrypted networks.

• When connecting to a Wi-Fi network for the first time, the Comcast Connection 
Manager may display the New Network Options prompt (see page 22). You can use 
this dialog box to configure the Comcast Connection Manager to automatically 
connect to the network in the future or to prompt you when that network is available.
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Options for Connecting to a New Network
If Prompt me before saving network settings is selected in the Automatic Profile Creation 
Settings Window (see “Automatic Profile Creation Settings” on page 35), you will see the 
dialog pictured below when you connect to a new Wi-Fi Network for the first time. The 
option selected specifies the type of profile that the Comcast Connection Manager will 
create for this network. By creating a profile automatically, the Comcast Connection 
Manager makes it easier for you to connect to the same network in the future.

You must choose one the following options:

Automatically connect to network in future
If this option is selected, the Comcast Connection Manager will automatically connect to 
this network whenever it is detected.

Note: When multiple networks that have been configured for auto-connection are 
detected, the Comcast Connection Manager will connect to the network whose profile is 
ranked highest in the Network Profiles window. See “Network Profile Priority” on page 31 
for more information on profile rank and how to change it.

Prompt me before connecting to this network
If this option is selected, the Comcast Connection Manager will notify you when this 
network is detected and offer to establish a connection to it. However, it won’t actually 
establish the connection unless you give your “OK.”

Save settings for manual connections
If this option is selected, the Comcast Connection Manager will save the connection 
settings you used to connect to this network so that you don’t have to enter them again, 
but it won’t connect to this network automatically. To manually connect to this network, 
select it in the Wi-Fi Networks List and then click the Connect button.
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Do not save settings
Choosing this option will allow you to connect to the network this time, but will not save 
parameters for future connections (no profile will be created).
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The List of Wi-Fi Networks
Clicking View All Wi-Fi link in the Comcast Connection Manager’s main window produces 
a list of all available networks.

Select a network and click the Connect button to connect. 

The information displayed for each network includes the items listed below.

Network Name
The Signal Set IDentifier (SSID) is the name that is broadcast by a Wi-Fi Access Point to 
identify the network.

A *closed* item in this column indicates the presence of one or more closed networks. 
Connecting to such a network requires the creation of a profile for that network. See 
“Accessing a Closed Network” on page 25 for more information.

Secured

Encrypted networks display the  icon in this column. See “Introduction to Wi-Fi 
Encryption” on page 26 for instructions on connecting to encrypted networks.

Preferred
A check ( ) is displayed for any Wi-Fi network that is listed in the Network Profiles 
window. This includes Wi-Fi networks for which you have created profiles and Wi-Fi 
networks for which a profile has been created automatically (see “Options for Connecting 
to a New Network” on page 22 for more about automatic profile creation).

Signal Strength
A gauge showing the strength of the signal detected from each network. Stronger signals 
tend to produce more reliable connections.
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Accessing a Closed Network
To access a closed network with the Comcast Connection Manager, you must set up a 
network profile for that network. Follow these steps:

1. Select Profiles from the Tools menu to display the Network Profiles window.

2. Select Add New Profile from the Settings menu. A list of network profile types now 
appears.

3. Select Wi-Fi.

4. Click Add. The first page of properties for the new profile appears.

5. Enter the name of the network you want to add in the SSID field exactly as provided 
by the network administrator.

6. Check This is a non-broadcasted network (Closed) to identify this as a closed 
network.

7. Fill out the remaining fields on this page as instructed by the network administrator.

8. Click Next to continue to the General page. 

9. Configure the fields on the General page as desired.

10. Click Finish to exit.
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Introduction to Wi-Fi Encryption
Comcast Mobile 4G Networks and Comcast Mobile 3G Networks are encrypted and 
connection to them secured using special software in your Comcast Mobile Broadband 
Devices. Similarly, Wi-Fi networks often use encryption technologies to protect data 
travelling over the network. Unlike Comcast Mobile 4G Networks and Comcast Mobile 3G 
Networks, however, connecting to an encrypted Wi-Fi network requires that you enter an 
encryption key. 

Encryption Keys
An encryption key is a code used to encrypt data exchanged between an encrypted 
network and the Comcast Connection Manager. You must obtain the appropriate 
encryption key from the administrator of an encrypted network in order to connect to that 
network.

What Does “PSK” Stand For?
PSK stands for “Pre-Shared Key,” which means that your encryption key has to be entered 
manually rather than using a protocol like 802.1x to obtain it from the network as part of 
the connection process. Because of its simplicity, PSK is the typical choice for home and 
small office environments. All Wi-Fi connections supported by the Comcast Connection 
Manager use the PSK method.

Wired Equivalent Privacy (WEP)
WEP is a standard encryption technology that has been used since the early days of Wi-Fi 
networks. Although even more secure methods such as WPA have since emerged, WEP 
remains an extremely popular choice for encrypted networks. There are two variants of 
WEP:

• WEP Open: This is by far the most commonly-used version of WEP. Networks that 
use WEP Open don't verify that you have the correct encryption key before allowing 
you to connect. However, if you don't have the connect encryption key, you won't be 
able to communicate with the network.

• WEP Shared: The network sends out sample text for the Comcast Connection 
Manager to encrypt. If the result that the network gets back is what it expected, it 
allows the connection. Ironically, this is somewhat less secure than WEP Open 
because the verification process gives potential intruders a large hint about the 
contents of the encryption key.
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Wi-Fi Protected Access (WPA and WPA2)
Developed by an industry trade group known as the Wi-Fi Alliance, WPA is an interim 
standard meant to address the shortcomings of WEP. WPA2 is a newer standard that 
succeeded WPA, but both versions remain in common use.

To use WPA, you need a WPA-compliant Wi-Fi device.

What are TKIP and AES?
Temporal Key Integrity Protocol (TKIP) and Advanced Encryption Standard (AES) are 
different encryption protocols that can be used with WPA. TKIP is the method that was 
called for in the original WPA Specification. AES, which is even more secure, was added 
as an alternate method to later versions of the specification. If network uses WPA, but 
doesn't specify which one, TKIP is the most likely to be supported by the network.

Connecting to an Encrypted Network
When you choose to Connect to an encrypted network, the software will prompt you to 
enter a network encryption key. To proceed, enter a network encryption key obtained from 
the network administrator and then click the Connect button on the prompt dialog.

Tip: You can create a profile containing the appropriate encryption information to avoid 
having to manually enter an encryption key each time you connect. See “Creating a Profile 
for a Wi-Fi Network” on page 32 for more information.
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5Network Profiles

What is a Network Profile?
A network profile contains the configuration information needed to connect to a particular 
network. Mobile Broadband profiles are predefined by Comcast (though some 
configuration options are available). Wi-Fi profiles can be created in the Network Profiles 
window or created automatically when you connect to a new Wi-Fi network.

Among other things, network profiles allow you to:

• Configure the Comcast Connection Manager to automatically connect using the 
profile’s settings whenever the associated network is available.

• Prioritize networks to help the Comcast Connection Manager choose which network 
to connect to. 

• Save settings, such as encryption keys for Wi-Fi security or VPN configuration, to 
enable one-click connection.
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The Network Profiles Window
Network profiles can be added and configured in the Network Profiles window. To access 
the Network Profiles window, click the Profiles button in the main window. 

The left pane of this window lists of all the Network Profiles you have defined so far. Also 
listed are any Network Profiles that have been pre-configured by Comcast and any 
profiles automatically added when you first connected to a new network. 

A profile's position in the list indicates its priority. See “Network Profile Priority” on page 31 
for more information. 

Profile Icons
Each profile listed in the Network Profiles window has an icon next to the name. This icon 
indicates the technology that this profile uses to establish connections.

 Comcast 3G Mobile 

Comcast 4G Mobile

 Wi-Fi

 Unmanaged Connections - this is a placeholder for types of networks not 
managed by the Comcast Connection Manager. See “Network Profile Priority” 
on page 31 for more information
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Network Profile Priority
In the Network Profiles window, profiles are listed in order of priority. When selecting a 
network to connect to, the Comcast Connection Manager will choose the topmost profile 
for which all of the following are true:

• The network described by the profile is available

• You have a device capable of connecting to the network connected to your computer 

• The Connection Options field on the General tab in the profile's configuration is set to 
either “Automatic” or “Prompt”

• The profile is not “Unamanaged Connections” (see below)

Profile priority also determines when the Comcast Connection Manager will automatically 
switch from one network to another. If you are connected to one network and a higher 
priority network becomes available, the Comcast Connection Manager will switch to the 
higher priority network.

Note: Automatic connection switching only occurs when in automatic connection mode. 
The Comcast Connection Manager starts out in this mode each time it is launched, but 
switches to manual mode if you manually choose a network and click Connect. To return 
to automatic mode, restart the Comcast Connection Manager application.

Changing Profile Priority 
To change the priority of a specific profile, select the profile whose priority you would like to 
change. Then, click the Up button or the Down button to move the profile up or down the 
list.

Unmanaged Connections
“Unmanaged Connections” is not a network profile. It is a placeholder for all network 
connections that are not managed by the Comcast Connection Manager software. The 
placement of this item in the list determines how high priority these unmanaged 
connections should be considered. 

Ethernet LAN connections are an example of connections not managed by the Comcast 
Connection Manager. If “Unmanaged Connections” is at the top of the list, Ethernet LAN 
connections would take precedence over the wireless connections managed by the 
Comcast Connection Manager and your managed wireless connection would be shut 
down when you connect to your LAN. If, on the other hand, “Unmanaged Connections” is 
at the bottom of the list, the managed connection would not be shut down.

Note: You can specify which devices are included in the “Unmanaged Connections” 
group in the Hardware tab of the Settings window.
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Creating a Profile for a Wi-Fi Network
Perform these steps to create a Wi-Fi network profile.

1. Click the Profiles button in the main window. The Network Profiles Window will now 
be displayed.

2. Select Add New Profile from the Settings menu. A list of network profile types now 
appears.

3. Select Wi-Fi.

4. Click the Add button to bring up the first page of the wizard used to create Wi-Fi 
network profles.

5. In the SSID Field, enter the broadcast name of the network to which you will be 
connecting. Note that the name entered here must match the SSID (Service Set 
IDentifier) used by the network exactly.

6. If the network is a Closed network, check the This is a non-broadcast network box.

7. If the network whose profile you are configuring does not use WEP or WPA 
encryption, leave the Enable data encryption box unchecked.

—or—

If the network uses WEP or WPA encryption, check the Enable data encryption box 
and configure the Wi-Fi Data Encryption Settings as explained in “Configuring Wi-Fi 
Data Encryption” on page 34.
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8. Click the Next Button. The General page appears (see page 38).

9. Configure the settings in the General page as desired and then click Finish.
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Configuring Wi-Fi Data Encryption

1. Contact the administrator of the network to obtain information needed for access, 
such as the security method used, encryption keys required, etc. 

2. Check the Enable data encryption box.

3. Select the appropriate Authentication method for this network. Supported 
authentication methods include the following:

• None: For an unencrypted network.

• WEP-Open (Normal Method): This is the standard WEP encryption method.

• WEP-Shared: Similar to WEP-Open, but the base station asks the client to prove 
that it has the right key before the connection is established.

• WPA-PSK (TKIP or AES): This is the pre-shared key version of the WPA 
protocol.

• WPA2-PSK (TKIP or AES): This is the pre-shared key version of the WPA2 
protocol.

Note: The WPA methods listed above will only be displayed if your Wi-Fi adapter 
supports WPA security.

4. Enter the encryption key for this network in Network Key and Confirm Network Key 
fields.

Note: Normally, the display of the encryption key will be obscured for privacy 
reasons. If you prefer to actually see the key’s text, check the Show network key in 
clear text box.
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Automatic Profile Creation Settings
The Comcast Connection Manager can automatically create network profiles for each new 
Wi-Fi network you successfully connect to. The setting that controls this can be found by 
selecting Automatic Profile Creation from the Settings menu in the Network Profiles 
window. Choose from the following options:

• Automatically save all networks that I connect to — The Comcast Connection 
Manager will create a new profile for every new Wi-Fi Network you successfully 
connect to.

• Prompt me before saving network settings — The Comcast Connection Manager will 
ask you if you want to create a new profile each time you successfully connect to a 
new network.

• Allow manual input of network settings only — The Comcast Connection Manager 
will not automatically create network profiles.
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Editing a Network Profile
You can edit all of the settings contained in Wi-Fi network profiles. A reduced set of 
parameters will be available for modification in profiles that were created for you by 
Comcast.

1. Click the Profiles button in the main window. The Network Profiles window appears.

2. Select the profile you wish to edit in the left pane of the window.

3. Click the Edit button. A tabbed interface showing all the user-editable settings of the 
selected profile appears. Depending on the type of profile you are editing, the 
following tabs may be displayed:

• Wi-Fi (see page 37)

• General (see page 38)

4. Make the desired changes.

5. Click the OK button when you are finished.

Deleting a Network Profile
Follow these steps to delete a profile from the Network Profiles window:

1. Click the Profiles button in the main window. The Network Profiles window will now be 
displayed.

2. Select the profile that you want to delete from the list in the left pane of the window.

3. Click Remove. A prompt that asks if you are sure you want to delete this profile 
appears.

4. Click Yes to confirm that you want to delete the profile.

Note: You cannot delete network profiles that were created for you by Comcast.
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Profile Properties: Wi-Fi
The Wi-Fi page contains the security settings for Wi-Fi network profiles.

• The version of this window pictured on the left below appears when creating a new 
profile. 

• The tabbed version on the right appears when editing an existing profile. 

Although the window controls vary, the actual parameters included are identical for both 
versions. 

Follow these steps to configure Wi-Fi network security:

1. In the SSID field, enter the name broadcast by the network for which you are creating 
a profile. The name entered here must match the SSID (Service Set IDentifier) used 
by the network exactly.

2. If this is a closed network, check This is a non-broadcast network (closed).

3. If the network does not use WEP or WPA encryption, leave Enable data encryption 
unchecked and no further configuration is necessary on this page.

If the network does use WEP or WPA encryption, check Enable data encryption and 
configure the Wi-Fi data encryption settings. (See “Configuring Wi-Fi Data 
Encryption” on page 34).
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Profile Properties: General 
The General page contains settings that apply to all types of network profiles. 

• The version of this window pictured on the left below appears when creating a new 
profile. 

• The tab version on the right appears when editing an existing profile. 

Although the window controls vary, the actual parameters included are identical for both 
versions.

Note: Some of the options pictured on this page may not be available if you are editing a 
profile created for you by Comcast.

Profile Name
The name entered here will be displayed in the Network Profiles window and the Comcast 
Connection Manager’s main window.
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Connection Options
This setting controls what the Comcast Connection Manager will do when it detects the 
network to which this profile applies. Select one of the following options:

• Automatic — The Comcast Connection Manager will automatically connect to this 
network whenever it is detected.

• Prompt me — The Comcast Connection Manager will ask you whether to connect to 
this network each time the network is detected.

• Manual — Connections to this network may be established using the controls in the 
main window or by selecting it in the Network Profiles window and then clicking 
Connect, but the Comcast Connection Manager will not connect to this network 
automatically.

VPN Auto Launch
Check this box if you would like to automatically launch your VPN client software when 
you establish a connection to this network. Click the accompanying Settings button to 
open the VPN tab of the Settings window.

Disable IE’s manual proxy settings on connect
If you normally connect to the Internet through a proxy server (common on corporate 
LANs), you may experience difficulty connecting to the Internet with Internet Explorer 
when you are traveling. This is because Internet Explorer is trying to connect through a 
proxy server that is on your home network rather than on the network to which you are 
connected.

If this is the case, you can check this box to disable proxy server settings while you are 
connected using this profile.

Launch browser window on connect
Check this box to automatically launch your browser each time you connect to this 
network. If you want the browser to start at a particular Web page each time you connect 
to this network, enter its web address in the Start URL box.
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6Virtual Private Networks 
(VPNs)

What is a Virtual Private Network?
A Virtual Private Network (VPN) is a private network that can be accessed over a public 
backbone network (like the Internet) without compromising the privacy of the VPN. 
Typically, VPNs maintain their privacy by forming secure (encrypted) “tunnels” directly to 
users who access them. For example, a company might set up a VPN for its employees to 
access their corporate network securely when they are away from the office.

The software responsible for forming the tunnel with the private network is called a VPN 
Client. Because the VPN Client and the private network exchange data in an encrypted 
format, no one on the public network over which this information passes can access it.

Supported Clients
Although the Comcast Connection Manager is not a VPN Client itself, it can automate the 
launching of your VPN Client software when needed. The Comcast Connection Manager 
has been tested with the following VPN Clients and even automates certain tasks for these 
clients:

• Microsoft

• Cisco

• Nortel

• Checkpoint (please see “Using the Checkpoint VPN Client” on page 44 for important 
caveats)

• NetMotion (please see “Using the NetMotion VPN Client” on page 44 for important 
caveats)

The Comcast Connection Manager can also launch other VPN Clients, but may require 
more manual configuration to do so. 
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Configuring a VPN Connection
As with any other secure network, accessing a VPN requires some security-related 
configuration. Perform these steps:

1. Consult the administrator of the VPN you wish to access. The administrator will 
provide you with VPN Client software and instructions for establishing VPN 
connections.

2. If the VPN Client software is not already installed on your system, install it now. 
(Microsoft's VPN Client is pre-installed on most versions of Windows).

3. Follow your administrator’s instructions for setting up a VPN Login Profile.

4. Access the VPN tab by selecting the Settings option in the Tools menu and then 
clicking the VPN tab.

5. If the VPN client software you are using is supported by the Comcast Connection 
Manager, select Use existing VPN profile. Then, specify the client software and the 
login profile that you want to use.

If the VPN Client software you are using is NOT supported by the Comcast 
Connection Manager, select Use Third Party VPN Client. Then, click the Browse 
button to specify the location of the client software that you are using.

6. Click the OK button to exit the Settings window.

Once your VPN Settings have been configured, you can configure network profiles to 
automatically start your VPN Session upon connection. See “Automatically Launching a 
VPN Connection” on page 43.
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Automatically Launching a VPN Connection
You can configure a network profile to automatically launch your VPN Client and log into a 
VPN once the connection to a wireless network has been established. Follow these steps:

1. If you have not already done so, configure the connection settings for the VPN you 
wish to connect to. (See “Configuring a VPN Connection” on page 42).

2. Open the Network Profiles window by clicking the Profiles button in the main window.

3. In the left pane, select the profile for which you want to automate VPN connections.

4. Click the Edit button. The Edit Profile window for the selected profile appears.

5. If the General tab is not already selected, select it now.

6. Check the Auto Launch box.

7. Click OK to exit.

Tip: If you want your VPN Client to be launched automatically with all (or most) of the new 
profiles you create, consider checking the Set VPN autolaunch for newly created 
connection profiles box on the VPN tab of the Settings window. This configures the default 
behavior of all newly created profiles.
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Using the Checkpoint VPN Client
Although CheckPoint's VPN client provides a command line interface that applications 
such as the Comcast Connection Manager can use to establish connections, the user 
cannot access other modes of the CheckPoint VPN client while the client is in command 
line mode.

What does this mean for CheckPoint VPN users? Essentially, you should keep the 
Comcast Connection Manager open only when you have an active connection managed 
by the Comcast Connection Manager open. If you want to establish another type of 
connection with the CheckPoint VPN client, you MUST shut down the Comcast 
Connection Manager first. When the Comcast Connection Manager shuts down, it will put 
the VPN client back into a mode that users can access.

Using the NetMotion VPN Client
NetMotion's VPN client takes complete control of all data communication to and from your 
computer. This forces all data communication applications to go through the “tunnel” it 
creates. However, the Comcast Connection Manager needs to bypass this tunnel in order 
to establish connections. The Comcast Connection Manager will accomplish this in one of 
the following ways:

• The NetMotion VPN client maintains a list of applications that are allowed to bypass 
its VPN tunnel. If your VPN administrator has added the Comcast Connection 
Manager to this list, the Comcast Connection Manager can establish connections 
without interrupting the operation of the NetMotion client.

• If the Comcast Connection Manager has not been added to NetMotion's bypass list, 
the Comcast Connection Manager will detect that the NetMotion client is interfering 
with its operations when it attempts to establish a connection. When this happens, it 
will instruct the NetMotion client to enter bypass mode (which allows all applications 
to bypass its tunnel) while the connection is being established. Once the connection 
has been successfully established, the Comcast Connection Manager will return the 
NetMotion client to its normal operating mode.



Page 45 

7Comcast Connection 
Manager Settings

Introduction
The Settings window allows you to configure the behavior of the Comcast Connection 
Manager software. Among other things, these settings control how the client connects to 
networks, when it retrieves updates and if its connections should time out.

To access the Settings window, Select Settings in the Tools menu.

Settings: General
The General Tab contains general settings for the Comcast Connection Manager 
software. 
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Automatically run this application on machine startup
When this box is checked, the Comcast Connection Manager will be launched 
automatically each time you start your computer.

Use this as my default Wi-Fi management utility
If this box is checked, the Comcast Connection Manager will manage all Wi-Fi 
connections on your computer when it is running. If you wish to return control of Wi-Fi 
connections to the operating system (or to another application), you must exit the 
Comcast Connection Manager software.

When this box is NOT checked, the Comcast Connection Manager's Wi-Fi functionality is 
disabled.
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Settings: Updates
The Updates tab allows you to specify when updates to the Comcast Connection Manager 
software and device firmware are made.

Automatically download and install
Select this option to have the Comcast Connection Manager automatically download and 
install product updates at regular intervals (once a week).

Note: These updates are silent (occur in the background). You will not see the update 
wizard when updates are downloaded silently.

Prompt me to download and install
Select this option to have the Comcast Connection Manager periodically prompt you to 
download and install product updates.

Manually download and install
Select this option if you want product updates to be downloaded only when you click the 
Update Now button below.
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Update Now
Click Update Now to have the Comcast Connection Manager immediately check for and 
download available updates.
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Settings: Hardware
The Hardware tab is used to configure hardware-related settings for connection 
establishment.

The following items can be found on this tab:

The Device List
This table lists all the devices connected to your computer that may be used to establish 
network connections. Among other things, this table allows you to:

• Enable and disable individual devices.

• Choose between multiple device of the same type.

• Configure additional properties for Comcast 3G Mobile Broadband Devices.

 For more information, see “The Device List” on page 51.
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Prompt before switching connections
When in automatic connection mode, the Comcast Connection Manager software 
automatically switches to a higher priority network if one becomes available. This has the 
potential to disrupt any activity that was relying on the original connection.

Checking this box will cause the Comcast Connection Manager to prompt you for 
permission before establishing the connection to the new network.

The Profiles Button
Click this button to open the Network Profiles window.
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The Device List
The device list is a table that appears on the Hardware tab of the Settings window. It is 
primarily used to select and configure connected devices.

Devices Column
This column lists all of the network access devices installed on your computer, grouped by 
the connection technologies they use. Each technology type heading is followed by the 
device names of the specific devices of that type that are installed on your computer. The 
technology types are:

• Wi-Fi Devices

• 3G Mobile Devices

• 4G Mobile Devices

• Unmanaged Devices

Note: The network devices listed under Unmanaged Devices are not managed by the 
Comcast Connection Manager application. So, the configuration in this window works a bit 
differently for them. See “Unmanaged Devices” on page 52 for more information.

Selection Column
This column allows you to specify which devices should be used to connect. The choices 
for this column are:

• Automatic: The Comcast Connection Manager will automatically choose the best 
device for this technology type.

• Manual: Allows you to manually select the device to be used. After selecting this 
option, check the box next to the device you wish to use.

• Disabled: This option is useful when you are using a multi-function wireless device 
that can only use one wireless mode at a time. For example, you may have a Wi-Fi/
Mobile Broadband Device that can't access both types of network at the same time. 
When using such devices, you may have to temporarily shut down the Comcast 
Connection Manager's use of one of these functions when you want to use the other 
technology.

Status Column
This column identifies the operational status of the device. It indicates whether the device 
is On or Off.
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Property Column
Additional properties (such as roaming) may be configured for devices if a Modify button is 
displayed in this column. Click Modify to open a pop-up window that provides additional 
configuration options for the device. Currently, only 3G Mobile Broadband Devices have 
such a window. (see“Device Properties” on page 53)

Unmanaged Devices
Unlike other categories in the device list, “Unmanaged Devices” are NOT supported by the 
Comcast Connection Manager. Although the Comcast Connection Manager cannot use 
these devices to establish connections, it can detect when a device in this category has 
established a connection and (if you desire) shut down its own connections when this 
occurs. 

To monitor the connection status of a device in this group, check the box in the Selected 
column. Connections for all checked devices will be included in the Unmanaged 
Connections group in the Network Profiles window. See “Network Profile Priority” on 
page 71 for more information on the Unmanaged Connections group.

Note: the Automatic/Manual Disabled dropdown menu at the top of the Unmanaged 
Devices group must be set to Manual to change which devices are checked.

The Automatic/Manual/Disabled dropdown menu at the top of the Unmanaged Devices 
group determines the default state of the checkbox for newly-detected device. 

• If the dropdown is set to Automatic, new devices added to the other group will be 
checked by default.

• If the dropdown is set to Manual, you can manually configure which devices are 
checked an which are not checked. Additionally, new devices will be unchecked by 
default. 
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Device Properties
The Device Property window contains three sections used to configure the behavior of 3G 
mobile devices connected to your computer.

Roaming Selection
Configure permission for the Comcast Connection Manager to connect to roaming 
networks. Consult your service agreement for more information about roaming service 
and any charges that such service might incur. You can choose one of these options:

• Auto — connects to Comcast’s network when available, using roaming networks only 
when a connection to Comcast’s network is not available.

• Home Only — connects only to Comcast’s network. Never connects to other 
networks.
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Use the Roam Guard pull-down menu to specify whether you would like the Comcast 
Connection Manager to display a warning message when you are about to connect to a 
roaming network for which there may be additional roaming charges.

• Always Ask: always prompt you before connecting to a roaming network.

• Never Ask: never ask before connecting to a roaming network.

• Default: display the prompt when the Extended Roaming Indicators (ERI) file on your 
mobile device says it is necessary to do so.

Mode
This menu allows you to specify which network technology is used to establish 3G Mobile 
Broadband data connections.

• Automatic: The Comcast Connection Manager will automatically select the best fit for 
your Comcast 3G Mobile Broadband Device. 

• CDMA 1xRTT: Code Division Multiple Access utilizing the older 1 times Radio 
Transmission Technology. 

• CDMA EVDO: Code Division Multiple Access utilizing the faster Evolution-Data 
Optimized (EVDO) Technology.

Connection Type
This setting determines which software interface the Comcast Connection Manager 
should use to communicate with your Comcast 3G Mobile Broadband Device. 

• NDIS allows more efficient communication with devices that support it.

• RAS is supported by more devices.

Note: Many 3G Mobile Broadband Devices support only one of these interfaces. If this is 
the case with your device, the interface that your device supports will be selected by 
default and you will not be able to change the selection.
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Settings: Connection Timeout
The Connection Timeout tab allows you to specify if and when the Comcast Connection 
Manager will automatically shut down a connection.

Configuring Duration Timeouts
A duration timeout is a maximum time allowed for any connection. So, a duration timeout 
of 30 minutes will shut down any connection that lasts longer than 30 minutes.

To configure a duration timeout, check the Enable Duration Timeout box. Then, specify the 
number of minutes after which the timeout should occur. 

If you want the Comcast Connection Manager to warn you before it disconnects for a 
duration timeout, check the Display warning before timeout box.

Configuring Inactivity Timeouts
Configuring an inactivity timeout instructs the Comcast Connection Manager to disconnect 
if there has been little or no data exchanged on a connection for a specified number of 
minutes.

To configure an inactivity timeout, check the Enable Inactivity Timeout box. Then, specify 
the number of minutes of inactivity that will trigger the timeout.
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Settings: VPN
The VPN tab specifies how the Comcast Connection Manager accesses Virtual Private 
Networks.

The top item, Do Not Use VPN, disables the Comcast Connection Manager's capacity to 
log into VPNs. Select this option if you do not wish to establish connections to Virtual 
Private Networks.

You must choose one of the other two options and fill in the corresponding fields if you 
wish to automatically log into a VPN when you connect to a specific network (see 
“Automatically Launching a VPN Connection” on page 43).

Use existing VPN profile
Select this item if the VPN client software you will be using is supported by the Comcast 
Connection Manager. Then, specify the supported client software and the login profile that 
you want to use. See “Supported Clients” on page 41 for more information on supported 
VPN client software.
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Use third party VPN client
Select this item if the VPN client software you will be using is NOT supported by the 
Comcast Connection Manager. Follow these steps to configure the Comcast Connection 
Manager to launch the unsupported software:

1. Click the Browse button.

2. Select the program file to be launched.

3. Click Open. The path of the selected file should now appear in the Command Line 
box.

4. If your VPN client software requires that additional parameters be included after the 
program filename on the command line, these may be entered in the Parameters 
box. Consult the documentation for your VPN client to determine if such parameters 
are needed.

See “Supported Clients” on page 41 for more information on which VPN client software is 
supported.

Set VPN autolaunch for newly created connection profiles
If this box is checked, all new network profiles created will be configured to automatically 
launch your VPN upon successful connection. If this box not checked, new profiles will not 
connect to your VPN until you follow the instructions in Automatically Launching a VPN.

Note: This setting specifies the initial state of the VPN Autolaunch box on the General 
page of settings for each new profile (see page 39). You can easily change this setting for 
an individual profile after the profile is created.
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8Troubleshooting Tools

Event History Manager
Select Diagnostics > Event History from the Tools menu to see a log of events (for 
example, connections, disconnections, errors). The window shown below will appear.

You can do the following in this window:

• Double-click on any item in the list to see more information about that event

• Use the options in the Filter by section to limit the events displayed to a particular 
date range, connection technology or event type.

• Click on the Reset Event History Manager button to delete all the currently-logged 
events.
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Wi-Fi Network Information
To view information about a Wi-Fi network you are currently connected to or about your 
current Wi-Fi device, select Diagnostics > Wi-Fi Info from the Tools menu. This produces 
the window shown below.

Network Tab

IP Address
The Internet address your computer is using for the current Wi-Fi network connection. 
Ordinarily, the address displayed here is assigned only for the duration of the current 
connection. It is most likely NOT permanently assigned to your computer.

Gateway
The address of the device that is responsible for routing all of the network traffic you send 
over the Wi-Fi connection.

DNS Server
The address of the server your computer is using to translate textual Internet addresses 
(like Comcast.com) into the numerical addresses used natively by the Internet Protocol.



Page 61 

DHCP Server
The address of the server that assigned your computer's network configuration for the 
current wireless connection.

WINS Server
The address of the server (if any) that your computer is using to find the names of 
computers on a Windows network. 

Activity
The number of packets of data that your computer has sent and received over the Wi-Fi 
connection since it was established.

Device Tab

Vendor Description
The name of your Wi-Fi device, as reported by its on-board operating software.



Page 62

MAC Address
The Hardware Address of the device. MAC (Media Access Control) addresses are 
pre-configured by the device's manufacturer and usually cannot be altered. These 
addresses are used for transferring data by hardware-level protocols such as Ethernet 
and 802.11 (Wi-Fi). Higher level protocols such as the TCP/IP Protocol Suite used by the 
Internet have their own addressing schemes, but still rely on the hardware-level protocol 
for the transfer of data between individual nodes on a network.

Driver Version
The version of the driver for this device that is currently installed on your computer.

Firmware Version
The version of the device's on-board operating software.
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Comcast Mobile 3G Info Window
To view information about your Comcast 3G Mobile Broadband Device and/or your 
Comcast Mobile 3G connection (if any), select Diagnostics > Comcast Mobile 3G Info from 
the Tools menu. The window shown below will appear.

Note: The information displayed in this window is provided by your Comcast 3G Mobile 
Broadband Device and its drivers. If the device does not provide this information or the 
information provided is incorrect, this will be reflected in the displayed data.

Device Tab

Device Name
The name used internally by software applications to uniquely identify your Comcast 3G 
Mobile Broadband Device.
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Device Description
The commercial name of your Comcast 3G Mobile Broadband Device.

Manufacturer
The name of the manufacturer of your Comcast 3G Mobile Broadband Device. 

Modem Model
The model name of your Comcast 3G Mobile Broadband Device.

Revision
The revision field contains manufacturer-specific information about the version of your 
device. It may, for example, contain additional information about your device's model 
number or its firmware version.

ESN
Your Comcast 3G Mobile Broadband Device's Electronic Serial Number.

Technology
The type of Comcast 3G Mobile Broadband Device you are using (CDMA or GSM).

Firmware Version
The version of your Comcast 3G Mobile Broadband Device's on-board operating software.

Hardware Version
The version of your device's hardware.

Modem Port
The communications (COM) port that your Comcast 3G Mobile Broadband Device is 
currently attached to.

User Name
Your Network Access Identity (NAI), usually in the form of username@companyabc.com.

Phone Number (MDN)
The telephone number of your Comcast 3G Mobile Broadband Device.
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Home Carrier Name
The name of the wireless service provider that your Comcast 3G Mobile Broadband 
Device considers to be its “home” network.

Home Carrier ID
The ID of the wireless service provider that your device considers to be its “home” 
network.

PRL Version
The version of the file on your device that contains the Preferred Roaming List.

MSID (IMSI_S)
Your Comcast 3G Mobile Broadband Device's IMSI (International Mobile Subscriber 
Identity) code. The IMSI allows any mobile network to know the home country and network 
of the subscriber.
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Network Tab

Network Name
The name of the 3G mobile carrier to which you are currently connected.

System ID
The ID of the network to which your Comcast 3G Mobile Broadband Device is currently 
connected.

Connected
Indicates whether you are currently connected to a 3G Mobile Broadband network.

Roaming
Indicates whether you are currently connected to a 3G Mobile Broadband network other 
than Comcast’s network.
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MIP Error
The last Mobile IP Error Code reported by your Comcast 3G Mobile Broadband Device.

Signal Strength (dBm)
The strength of the signal being received from this network, expressed in dBm. 

Data Sent
The amount of data sent over this connection since it was established (in bytes).

Data Received
The amount of data received over this connection since it was established (in bytes).

IP Address
The IP Address you are using for the current 3G Mobile Broadband connection. Ordinarily, 
the address displayed here is assigned only for the duration of the current connection. It is 
most likely NOT permanently assigned to your computer.

Gateway Address
The address of the default gateway that has been assigned to your device.
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Comcast Mobile 4G Info Window
To view information about your Comcast 4G Mobile Broadband Device and/or your 
Comcast Mobile 4G connection (if any), select Diagnostics > Comcast Mobile 4G Info from 
the Tools menu. The window shown below will appear.

Note: The information displayed in this window is provided by your Comcast 4G Mobile 
Broadband Device and its drivers. If the device does not provide this information or the 
information provided is incorrect, this will be reflected in the displayed data.

Device Tab

This page displays various information about the Comcast 4G Mobile Broadband Device 
currently attached to your computer.

MAC Address
The Hardware Address of the device. MAC (Media Access Control) addresses are pre-
configured by the device's manufacturer and usually cannot be altered. These addresses 
are used for transferring data by hardware-level protocols such as Ethernet or WiMAX. 
Higher level protocols such as the TCP/IP Protocol Suite used by the Internet have their 
own addressing schemes, but still rely on the hardware-level protocol for the transfer of 
data between individual nodes on a network.

Library Version
The version of the software interface of the device’s 4G Mobile chipset.

Firmware Version
The version of your Comcast 4G Mobile Broadband Device's onboard operating software.
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Driver Version
The version of the driver for this device that is currently installed on your computer.

BaseBand Chip
The version of the chip in your Comcast 4G Mobile Broadband Device that formulates the 
baseband 4G mobile signal.

RF Chip Version
The version of the chip in your Comcast 4G Mobile Broadband Device that modulates and 
multiplexes the baseband 4G mobile signal for RF transmission.

Calibration Status
This indicates whether your Comcast 4G Mobile Broadband Device has been calibrated.

Antenna Calib
This item is not currently reported by the Comcast Connection Manager software.

Antenna Gain Diff
This item is not currently reported by the Comcast Connection Manager software.

Tx Power Offset
This item is not currently reported by the Comcast Connection Manager software.

MAC Version
This item is not currently reported by the Comcast Connection Manager software.

The Advanced Button
Click this button to open the Advanced Mobile 4G Info window.
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Network Tab

This page displays various information about the 4G mobile network you are currently 
connected to (if any).

IP Address
The Internet address your computer is using for the current 4G mobile network 
connection. Ordinarily, the address displayed here is assigned only for the duration of the 
current connection. It is most likely NOT permanently assigned to your computer.

Gateway
The address of the device that is responsible for routing all of the network traffic you send 
via 4G mobile.

DNS Server
The address of the server your computer is using to translate textual Internet addresses 
(like Comcast.com) into numerical addresses used natively by the Internet Protocol.

DHCP Server
The address of the server that assigned your computer's network configuration for the 
current 4G mobile connection.

WINS Server
The address of the server (if any) that your computer is using to find the names used by 
computers in a Windows workgroup.
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Activity
The number of packets of data that your computer has sent and received over the WiMAX 
connection since it was established.

Advanced Mobile 4G Information
Clicking the Advanced button on the Device page of the Mobile 4G Info window produces 
the Advanced Mobile 4G Info window (shown below). This window provides advanced 
information for troubleshooting a 4G mobile connection.

Rx Power
The strength of the signal received.

CINR
Carrier to Interference + Noise Ratio. This is an indication of how strong the desired signal 
is compared to any interfering signals and noise. This gives a slightly more accurate 
indication of the overall quality of the signal received than just the signal strength by itself.

BSID
Base Station ID. The ID of the base station you are currently connected to.

TX Power
The level of power your Comcast 4G Mobile Broadband Device is using to transmit.

Preamble Index
The Preamble Index of the 4G mobile base station sector you are currently connected to.



Page 72

About Comcast Connection Manager
Select About Comcast Connection Manager from the Help menu to see the version 
number of the Comcast Connection Manager software as well as the website for Comcast 
customer service.

Click the System Info button to see information about your computer's current 
configuration, which may be useful to a customer service representative in resolving a 
problems.
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9 Troubleshooting 
Procedures 

General Questions

How do I stop the Comcast Connection Manager from launching 
every time I restart my computer?
Follow these steps:

1. Select Settings from the Tools menu.

2. Select the General tab.

3. Remove the check from the Automatically run this application on machine startup 
box.

4. Click the OK button.

Who can I contact if I need assistance with the Comcast 
Connection Manager?
Support for the Comcast Connection Manager can be obtained through Comcast’s 
webbiest, http://customer.comcast.com or by phone at 1-866-206-2182. When contacting 
Comcast support, be sure to include the version of Windows and the type of wireless 
device you are using as well a description of the problem you are experiencing.
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Wi-Fi Questions

Why Does the Comcast Connection Manager Keep Scanning for 
Wi-Fi Networks?
The Comcast Connection Manager will continue to scan until it finds one or more available 
networks or hot spots. If it keeps scanning, there are most likely no Wi-Fi networks or hot 
spots in the area.

“Closed” networks are a special case. Although the Comcast Connection Manager can 
detect whether closed networks are in the area, it can’t actually identify (or connect to) 
individual closed networks without probing for these networks using their exact names. To 
enable this, you have to create a profile for the network you wish to connect to. See 
“Accessing a Closed Network” on page 25 for more information.

Why do I keep losing my connection?
This may be due to interference caused by other devices like cordless phones, microwave 
ovens, and other 2.4GHz band devices. Move a few feet away from such devices.

Why am I unable to connect to a network that I can see in the 
Comcast Connection Manager?
Signal strength from the wireless Access Point may not be strong enough to allow reliable 
connections. It may not be a publicly available Access Point. Many companies or 
campuses will use wireless networking within their buildings, but will not grant public 
access.
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Device Issues
In some circumstances, the Comcast Connection Manager will not be able to use your 
Wi-Fi, Comcast 3G Mobile Broadband Device or Comcast 4G Mobile Broadband Device. 

A network name displayed in the main window will turn gray when the corresponding 
device has been disabled or if the device’s presence is not currently detected by the 
Comcast Connection Manager.

Device Disabled
All of the devices used by the Comcast Connection Manager can be disabled by Microsoft 
Windows. If this is the case, you can re-enable the device.

Resolution
You can enable an attached wireless device by selecting Enable Comcast Mobile 3G, 
Enable Comcast Mobile 4G or Enable Wi-Fi from the File menu.

Note: On Windows Vista systems, these options may be unavailable (grayed out) at all 
times. This may be because of security restrictions in your Microsoft Vista security 
configuration. Running the application as an administrator may allow access to these 
options. Follow these steps:

1. Close the Comcast Connection Manager.

2. Right click on the Comcast Connection Manager icon on your computer’s desktop. A 
short menu appears.

3. Select “Run As Administrator” from this menu.

No Wireless Device Detected
Failure to detect the device may result from any of the following causes: 

• Devices that must be tethered to your computer with a data cable (such as USB), but 
are not currently properly connected. Make sure the cables for devices that require 
them are properly attached to both your computer and the device.

• External devices that are not currently powered on. Make sure external devices are 
switched on. Make sure the batteries of battery-powered devices are charged. Make 
sure devices that must be plugged into an electrical outlet are plugged in.

• PC Card, USB, or Express Card devices that are not properly inserted. Make sure 
such devices are firmly seated in the appropriate slots.
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• The wrong device is selected in the Hardware Tab of the Settings Window. Ordinarily, 
automatic selection should be specified in the “Selected” column. If Manual selection 
is specified, verify that the selected device is the device you are trying to use. See 
“Settings: Hardware” on page 49 for more information.

• No driver or incorrect driver installed. Ensure that the latest drivers for the device are 
correctly installed according to the instructions of the device’s manufacturer.
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Numbered Errors
The most commonly-reported connection errors are listed below, along with some advice 
on their resolution.

Error 67 
Possible causes for this error include the following:

• Mobile Broadband Device account credentials have changed.

• Mobile Broadband Device is no longer provisioned for service.

Resolution
Contact Comcast Customer Service to ensure that your device is properly provisioned and 
that there are no problems with the account.

Error 131
Your Mobile Broadband Device account credentials may have changed.

Resolution
Contact Comcast Customer Service to ensure that your device is properly provisioned and 
that there are no problems with the account.

Error 619
A connection to the remote computer could not be established, so the port used for this 
connection was closed. Possible causes for this error include the following:

• Network resources are unavailable.

• Attempting to reconnect before your Mobile Broadband Device has finished 
disconnecting from a previous call.

• Your Mobile Broadband Device may be malfunctioning.

Resolution
• Wait 30 seconds, and then try to connect again.

• Remove the Mobile Broadband Device and re-attach it to the computer.

• Reboot the computer.
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Error 628
The connection was terminated by the remote computer before it could be completed. 
Possible causes for this error include the following:

• Call was dropped due to poor signal.

• Call was dropped due to network congestion.

Resolution
• If indoors, move closer to a window, exterior wall or move to a higher level. Re-

orienting the computer/wireless device may help as well.

• Wait 30 seconds, and then try to connect again.

Error 633
The device is already in use or is not configured properly. Possible causes for this error 
include:

• There is a problem with the drivers installed for the wireless device.

• Another application such as a fax program or PDA device software is attempting to 
use the port.

Resolution
• Shut down all FAX and PDA software and launch the Comcast Connection Manager 

again. Examples of common applications that can cause this type of problem include: 
PalmSource Hotsync, Microsoft ActiveSync, and Blackberry Desktop Manager.

• Uninstall any other wireless device connection management software installed on the 
computer. 

• Re-install the Comcast Connection Manager.
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Error 668 
The connection was dropped. Possible causes for this error include:

• Poor signal.

• Network congestion.

Resolution
• If indoors, move closer to a window, exterior wall, or a higher level. Reorienting the 

computer or wireless device may help as well.

• Reboot the computer.

• Contact Comcast Customer Service to ensure that your device is properly 
provisioned.

Error 678
The remote computer is not responding. Possible causes for this error include:

• Poor signal.

• Network resources are unavailable.

Resolution
• If indoors, move closer to a window or exterior wall or move to a higher level. 

Reorienting the computer or wireless device may help as well.

• Wait 30 seconds, and then try to connect again.

Error 691
Access was denied because user name and/or password supplied is invalid on the 
domain. Possible causes for this error include:

• Poor signal.

• Mobile Broadband Device account credentials have changed.

Resolution
• If indoors, move closer to a window or exterior wall or move to a higher level. Re-

orienting the computer/wireless device may help as well.

• Reboot the computer.
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• Contact Comcast Customer Service to ensure that your device is properly 
provisioned.

Error 692 
There was a hardware failure in the device. Possible causes of this error include:

• Wireless device is defective or broken.

• Problem with PC Card Slot, ExpressCard slot, or USB port. 

Resolution
• Close the Comcast Connection Manager, reinsert the device, and launch the 

Comcast Connection Manager again.

• Reboot the computer.

• Try connecting the device to another slot (or port).

Error 718
PPP/Network Timeout. Possible causes for this error include:

• Poor signal.

• Network resources are unavailable.

Resolution
• If indoors, move closer to a window or exterior wall or move to a higher level. 

Reorienting the computer or wireless device may help as well.

• Wait 30 seconds, and then try to connect again.

• Reboot the computer.
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Error 719
PPP termination by remote machine. Possible causes for this error include the following:

• Poor signal.

• Network resources are unavailable.

Resolution
• If indoors, move closer to a window or exterior wall, or move to a higher level. 

Reorienting the computer or wireless device may help as well.

• Wait 30 seconds, and then try to connect again.

• Reboot the computer.

Error 777
The connection attempt failed because the connecting device on the remote computer is 
out of order. Possible causes for this error include:

• Poor signal.

• Network resources are unavailable.

• There is a problem with one of the wireless device drivers.

Resolution
• If indoors, move closer to a window or exterior wall, or move to a higher level. 

Reorienting the computer or wireless device may help as well.

• Wait 30 seconds, then try to connect again.

• Close the Comcast Connection Manager, reinsert the wireless device and launch the 
Comcast Connection Manager again.

• Reboot the computer.

• Uninstall any other software that manages wireless connections (if any are present 
on the computer).

• Reinstall the Comcast Connection Manager.
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